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LETTER FROM THE
PRESIDENT

Friends and New Customers:

We are pleased to bring you Kai’s Power Tools 3, a new level of tools and additions to
our award-winning, industry-leading Kai’s Power Tools. While many of you have
unleashed the creative and productive capabilities of previous versions of Kai’s Power
Tools, we believe you will be very pleasantly surprised with both our implementation of
features many of you requested in our earlier versions and with the phenomenal new
tools that come from the creative mind of Kai and our software development team.
New entrants to the creative world of Kai’s Power Tools will find nothing short of the
most powerful set of application plug-ins for Adobe Photoshop and other 100% Adobe
Photoshop plug-in extension compatible imaging applications.

KPT Lens f/x should delight even the most seasoned pro with its realtime drag and
image-processing capabilities utilizing unique custom controls that provide precise image
manipulation. KPT Spheroid Designer will delight the creative senses of finding whole
new ways to generate beautiful imaging utilizing that most basic shape in nature, the
sphere. KPT Interform take you to a whole new level of creating and controlling moving
or static textures which can be saved as Quicktime movies. We have added a whole
host of improvements existing customers have requested and others we believed you
would find useful.

Our goal in the development of Kai’s Power Tools 3 was to once again provide our cus-
tomers with a new level of performance, production and creative tools. We also wanted

Kai’s Power Tools Explorer’s Guide

JUIPISAJ Y} WOIf I



Letter from the President

to push beyond the boundaries of conventional software in user interface design and
the application of our advanced imaging technology. Our beta sites have provided us
with excellent support, feedback and constructive input as Kai’s Power Tools 3 has
moved from the lab into its commercial form. The overwhelmingly positive response we
have received from them and from the creators of Adobe Photoshop are a testament to
the depth and breadth of solutions and creative freedom that Kai’s Power Tools 3 deliv-
ers.

As you begin the process of designing using Kai’s Power Tools 3, we trust that you will
enjoy some of the innovations which have been embodied in the extensions. Our real-
time previewing capabilities break new ground. Our preset libraries, which include hun-
dreds of presets and which allow you to load or save your own presets, can all be
viewed and launched visually.

You now have a vast new array of image manipulation and creation techniques never
before available. There also are ways of producing complex images which only the most
dedicated designer (with dozens, or in some cases, hundreds, of free hours) (like we all
have...) could have created with existing applications. You will find Kai’s Power Tools 3
to be a serious production tool that provides you with new degrees of creative freedom.

Our team at MetaTools continues to explore new ways of expanding your visual design
horizons. We trust that you will find the journey exciting and fruitful. We look forward
to you constructive criticism and suggestions for ongoing development. Thank you for
your continued encouragement and support.

Sincerely,

John Wilczak
Founder and CEO
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FOREWORD BY KAT

Foreword to KPT 3.0 by Kai
The good old days were in 1992 in the summer.

Photoshop is just getting from 2.01 to 2.5 and Ben Weiss just joined me and John
Wilczak. With a single digit number of people at HSC, ostensibly working on an com-
puter controlled VCR project with Sony, we kind of stealthed it to do the concepts,
design, artwork and code for all of KPT 1.0 in a little over 4 months(!). We found our-
selves at CyberArts in November '92, cranking out floppies with hand-drawn Schnuffis
on them. We had to work around the clock to make the self-imposed deadline in the
end.

Skip ahead a couple of revisions, and now its the fall of 95 and with a team many times
the size we are still... working around the clock to make it just barely by the deadline!

Except now they are not quite so self-imposed any more, too. We have over a hundred
people, moved to Santa Barbara, and there are over a million copies out there of all the
things that came after KPT 1.0

Quite a ride it has been and with all the hiccups and all the birthing pains of a company
(as well as the births of three children for me and Barbara) I must say that all in
all.. THESE are the golden days all over again.

We poured a LOT of very fast paced work into this new baby and in many ways it is
truly amazing to see how far the concept of a plug-in has come. There are entire pro-
grams now living inside the hosts, possibly larger and more complex than the early ver-
sion of the hosts themselves...!

Kai’s Power Tools Explorer’s Guide
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Foreword by Kai

Often its hard for the 'user' to see all the details or follow all the decisions that have to
be made. Trade offs have to be balanced at every step. I wish it would be possible to
transfer the mindset as we sit here and try to make sane judgements of where to com-
promise.

With all the possible ways to focus on something as large as this there are obviously
many angles to criticize and wonder about the paths taken. Maybe we can explain a lit-
tle, maybe we can beg for the benefit of the doubt that they were almost always made
for some concrete reason ( with the obvious exception of the inevitable mishaps).

This time around we went for both Maximize and Minimize to push the limits.

As an example, when I design a plug-in interface I often times get asked why the
dialogs are so large... and there is a very specific answer for that: I would LOVE to
interact with the image in the way that Levels or Curves does, but the plug-in interface
as of today simply will not allow it. What that leads to is simply that the plug-in gets a
rectangle and is supposed to do something with the pixels in some other room and
then give them back.

Therefore ( and that's how the dominoes fall...) I opt to maximize the space in that other
room so I can have large previews and generous real estate for the huge amount of con-
trols, without getting into the Boeing Cockpit problem.

Most dialogs in 3.0 are therefore larger than before, with larger previews, more live
items wherever possible, a full screen test apply ( limited to the size of the dialog, too,
another reason for the maximized layout).

It is important to understand that anything in the background of such a modal dialog,
from the tool palette to the picture, the menu bar to the trash can, are all completely
unreachable and its a false sense of interactivity to see them behind the dialog. On large
monitors for reference that might be of interest still and so we kept that as a user pref-

10
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erence, but mostly we decided to really fade all other distractions to black while you
might lose yourself inside each filter.

That's for the maximize...

but in the middle of all that and VERY late in the schedule we also figured out some
rather nifty methods to go the other way and minimize totally...I ALWAYS wanted to do
one of these...:

What is called the "lenses" was in alpha known as the Dragon, as in "drag-on-the-
image"

and its design concept was so simple: make a precision instrument, like a little Swiss
Army knife or a watch or microscope ( it was also known as the fx Scope...) which has
just a few very tiny controls around a center window. In this window a number of
effects could be shown exactly as they would appear, over the real image, and updated
in realtime.

Its a lovely idea to keep all kinds of options hidden inside little wheels and dials that pop
out to set and hide themselves during use...I think we have barely begun to use all the
possibilities of that. And the actual interaction with the screen image is still a little
clunky, hampered by the very illegality of bypassing the plug-in interface altogether.

This could change soon and we surely wanted to bring out even the first attempts to do
things in this new minimal way. I think you will enjoy it very much and we hope to add
many more new options to it, record the motion, use it like a brush, change the size on
the fly, make multiple layers, in animation, etc etc etc. We surely are just as aware as our
friends out there as to what all we would love to see happen. Please trust that we
walked a fine line between what we could and could not do just now, and not all deci-
sions are mere technical barriers.

Kai’s Power Tools Explorer’s Guide
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Foreword by Kai

I often get rather ungrateful reactions by users with a quick knee-jerk reaction of "why
don't these bone-headed morons at least implement THAT thing here..?itREALLY
should do THIS (animation, layers, live apply, CMYK true conversions, multiplatformness,
etc etc etc) and often without a real understanding what the real-life obstacles might
have been.

Sure, we can be as bone-headed as the next set of guys, yup, thank you very much, but
in this case we also might have a few reasons to do what we did, or not yet do what we
didn't ....

That being said, it is always useful to get the feedback from actual users in actual
trenches out there, and we have gone to GREAT lengths to be in touch with our audi-
ence...

I travel an extraordinary amount, probably half a dozen globe hops each year, talk at
conventions and universities and seminars all over the place and all the while we all here
try to be reachable online with live chats and mail.

That too has been a really pleasurable part of the process over the last 3 years. I can
now go to the ends of the earth to Vienna or Tokyo and find a hundred or a thousand
people in a room clamoring for the new toys...

And something really has changed in the time span:

in the beginning we were really focused on solving production problems for production
people. But then we found out that its really a totally diverse group of people doing a
staggering variety of things with the tools. Often times the images might never leave the
4 walls of a user, they are simply enjoying the process of playing with their own creativi-
ty... and that's perfectly fine with us! SO often I have received mail from entire classes
of school kids 10 or 12 or 16, playing with KPT or Bryce just for the pure heck of it.

12
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Its almost as if they were playing with DOOM, except they are twirling pixels, not
intestines and in the end it spits out... a CAREER maybe..?

It gives me great pleasure to find the bartender at Piatti or the waiter at the Stone
House asking for the new rev, or as happened earlier this year, arriving at LAX to have
the immigration officer examine my green card very closely, comparing me to the silly
left-ear-exposed mugshot, looking rather sternly, only to look me in the eye and ask "so
when will Bryce animate??"... This is what it was all about in a way. Sitting there at 4
in the morning staring at glowing phosphor with a cuppa tea, well its the human bits of
warm and fuzzy that make it all worth while. Really not much different from creating a
movie or a CD or writing a book or painting a picture.

So I want to thank all of you out there helping us along in the quest to make this stuff,
and to make more of it and make it more and more powerful and faster and faster and
wilder and wilder.

Where WILL it end?

We do have quite the piracy going of course, sometimes it feels like all of entire coun-
tries are quite well served by a handful of copies, thank you very much... Well, you
might know my angle on this topic, its a very simple line:

No one can possibly buy everything there is just to check it out once...and so in that
sense its ok if you got it from Uncle Fred to have a peek. But, the 'ethics' angle for me
is: "If you use it more than once a week, or if you do any kind of professional project
with it, then by all means, invest in your tools and allow the toolmakers to make them
better for you"

and that seemed eminently reasonable and sensible and fair.

I have a lot of letters from folks that agreed and KPT was the first thing they ever paid
for.. ;)

Kai’s Power Tools Explorer’s Guide
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Foreword by Kai

What I also see in that sense is that if you just dabble about for fun, sure, anything goes
and your entire machine is probably quite an expensive sinkhole for cash as it is.
However, if you in any way at all make money with computers you really also should
make sure that you have the adequate tools... I see professional graphic artists with only
10 megs of Ram or saving everything to some syquest disk or designing magazine cov-
ers on an 8 bit screen. That really is being silly and pound-foolish in my eyes... The
machines have come a LONG way too, and now that Apple does not even make any-
thing less than a Powermac any more we did have to make a few hard choices to look
forward and not back...

If you are still on a 68k machine or even worse only on 8 bit graphics there will be some
parts of KPT that you are not seeing in full glory. Its not your fault of course, but one
can only hope that you do get to play with some of this on a 601 chip and up or a
Pentium for the PC version and certainly in 24 bits. The subtlety of the moving textures,
the soft shades of the spheroid lights, moving around bump maps in realtime, well all
that really comes to life with the new machines.

Who knows, you might see this on your friends fast box and it tips the scales as to 'why
should I get a new CPU anyway'...

I hope that if I find myself at fault to trigger your endless wallet drainage that at least
you never look back and are happier for it in the end.

And maybe, if you are the waiter or the immigration officer or the lawyer in daytime,
who knows... maybe this is the tool that suddenly lets you make web pages for
Madonna or a new logo for the pope.

Come to think of it.. he could use a new logo

I'll get right on it

14
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See you out there in analog molecule style soonish... short of that, come visit us on the
web in our slightly largoid site: http://www.hsc.com

And of yeah, as of tomorrow morning...we are also changing our name !
HSC was always just an apocryphal accident and were meaning to change it.
So here we found ourselves at a cross road to do it and we WENT for it...!

in the spirit of all we have done over the last three years we looked at what we hope to
do in the next

and the name fell in our lap: building tools

In Greek there is a word for the next level of something and its "Meta", such as the
books that followed after the books on physics, they were the books on MetaPhysics.

So we chose MetaTools as our guiding metaphor, so to speak ( Metad4 was taken...; )

and now we'll try to make that a name to swallow up HSC and make it something to be
proud of

http://www.metatools.com should be alive as well therefore

We have a LOT of new things up our sleeves and maybe the sheer variety of new items
in this gargantuan upgrade will give you a hint on what to come. 1996 should be a very
interesting year

The whole team for 3.0 would like to thank all our supporters over the past 3 years and
we hope to spiral up to new heights in our quest for the creation of MetaTools

greetoids from Santa Barbara, Kai and team

Kai’s Power Tools Explorer’s Guide
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ABOUT THIS EXPLORER’S
GUIDE

We’ve divided this Explorer’s Guide into three main sections.

You are currently reading the first section, which includes Getting Started, Introduction,
and a discussion of the various Apply Modes available in Kai’s Power Tools.

The second section contains the meat of this Explorer’s Guide—the detailed descriptions
of all of the plug-ins within Kai’s Power Tools, specifically the Spheroid Designer,
Gradient Designer, Texture Explorer, Interform, Fractal Explorer, Lens f/x (in its many
incarnations), and the six “Compact UI” plug-ins.

The third and final section contains information about two “classic” versions of KPT
plug-ins that have been included with your software, the Glossary and Index, and the
Acknowledgements and Software License Agreement.

Tips, Tricks, and Cool Techniques

Any tips, tricks, comments, etc. will appear in the outside margin in a smaller, italicized
font. To help you locate these tips more easily, they will also be offset with top and bot-
tom rules, as shown in the sidebar example.

Ticks and Trips

I remember one time when we were kids
and we went to visit our grandparents in
Georgia, my sister got this tick on her arm
and it was sucking blood and stuff and my
grandfather said to not pull it out ‘cause
its head would still be in her so we didn’t
and he got some oil and a lighter and
made it hot so the tick let go and fell off.
That was the only cool thing that hap-
pened during the whole trip.

(ahem...) Tips and Tricks

Look in the sidebars for tips, tricks, and
cool techniques for working with many of
the new features in version 3.0 of Kai's
Power Tools.

Kai’s Power Tools Explorer’s Guide
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About this Explorer’s Guide
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A sample hierarchical menu.

Terms and Conventions

If you are familiar with standard Macintosh or Windows operations, most of the terms
used in this Explorer’s Guide will already be familiar to you.

One phrase that we will be using quite a bit in this Explorer’s Guide is graphical user
interface, or just user interface. For the sake of brevity, we generally will use the
acronym U, for user interface, as in “the Spheroid Designer UL”

Furthermore, in this manual we make a distinction between clicking the mouse button
(which is a quick press and release) and pressing the mouse button (pressing and hold-
ing the mouse button down). We will, therefor, use the term “press and drag” versus
the more common, but (we believe) less accurate “click and drag.”

Host Applications

Also for the sake of brevity, we will refer to Adobe Photoshop, Fractal Design Painter,
Deneba Canvas and other applications which accept Photoshop-compatible plug-ins sim-
ply as the “host application.”

Hierarchical Menus

Whenever hierarchical menus are referred to in the text we will use the form Menu
Name > Menu Command > Sub-menu Command. We would refer to the following
example as Filter > KPT 3.0 > KPT Texture Explorer 3.0.

20

Kai’s Power Tools Explorer’s Guide



BEFORE YOU BEGIN

Since Kai’s Power Tools consist of a set of extensions which add functionality to a host
application program, you should be reasonably familiar with your host application pro-
gram (such as Photoshop) before you begin to use these extensions. If you are new to
your host program, we strongly suggest that you go through the tutorial included with
your graphics program, and then come back and experiment with Kai’s Power Tools.

Installation

Disk 1 of your Kai’s Power Tools 3.0 disk set contains an installer program to allow you
to quickly and easily install KPT 3.0 into any or all of your host applications. Below are
brief instructions for beginning the installation process. Once the installation process is
begun, simply follow the on-screen instructions to install KPT 3.0 onto your Macintosh
or Windows-based computer.

On a Macintosh: Insert the first installation disk into your computer. If necessary, dou-
ble-click on the disk icon to see the contents of the disk. Double-click on the icon
labeled “KPT3 Install.1” to begin installation. After the installation is completed, you

will be prompted to fill out and send an electronic registration “card.” After registering,
please read the KPT3 Read Me file for important information regarding last-minute
changes or enhancements to your software.

On a Windows-based computer: If necessary, launch Microsoft Windows (NT or 95).
Insert the first installation disk into your computer. If you are using Windows NT, select
the Run command from the File menu. If you are using Windows 95, select the “run”
command from the “start” menu. Type a:\setup and click the OK button or hit the
Enter key on your keyboard. After the installation is completed, you will be prompted to
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Before You Begin

fill out and send an electronic registration “card.” After registering, please read the
KPT3 Read Me file for important information regarding last-minute changes or enhance-
ments to your software.

For a step-by-step walkthrough of installing the software (for either Macintosh or
Windows-based computers), please refer to the installation sheet included in your KPT
3.0 box.

Technical Support

If you are a registered user of Kai’s Power Tools and would like technical assistance, the
best way to reach us is via America Online. If you are not on America Online, we can
also be reached via the Internet or by phone.

On America Online, we can be reached by using the keyword KPT to go to our online
forum, or you may send e-mail directly to KPT Support for technical assistance and gen-
eral questions. Response time is generally within 24 hours.

If you are not on America Online, you can send us e-mail via any Internet gateway (our
Internet address is KPTSupport@aol.com).

If you have access to the Web, check out our website at http://www.metatools.com.

Registered users may also contact our Technical Support Department, Monday through
Friday, 9:00 a.m. to 5:00 p.m. Pacific Standard Time, at (805) 566-6200.

Talk to Us Online

We invite you to get online and join the rapidly growing community of graphics profes-
sionals and enthusiasts who share knowledge and ideas in our weekly America Online
live chat, often hosted by Kai himself. Currently we meet Tuesday nights at 7:30 p.m.
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PST Use keyword KPT to enter our forum, then click on the HSC Chat button to enter
the fray!
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Kai’s Power Tools 3 (KPT 3) is a series of plug-in application extensions (plug-ins) which
extend the capabilities of Adobe Photoshop or any raster-based image-editing applica-
tion that fully supports the Adobe Photoshop plug-in architecture. (If you are not sure if
your host application fully supports Adobe Photoshop plug-ins, contact your software
publisher’s technical support team.) Once installed, the KPT 3 plug-ins will appear in a
KPT 3 submenu in the Filter or Effects menu of your host application program.
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What’s New

WHAT’"S NEW

New to version 3 of Kai’s Power Tools are KPT Spheroid Designer and KPT Interform. In
addition, some incredible new features have been added to the Gradient Designer and
Texture Explorer modules from version 2.1, and all of the “one-step” filters from the pre-
vious version have been clustered into either the KPT Lens f/x plug-in or the Compact
Uls, giving the user a host of previously unavailable controls such as intensity, direction,
apply mode, and more.

Along with entirely new plug-ins in Kai’s Power Tools 3, such as the Spheroid Designer
and Interform, we’ve introduced a host of new features into some of your old favorites,
namely the Texture Explorer and the Gradient Designer. Some of these include:

* The Info Box at the lower left hand of the interfaces. As you move your cursor,
the Info Box displays text indicating the function of whatever control you pass
over.

¢ 35 levels of undo and redo

*  Graphical Presets. Now you can view your presets in a field of thumbnails on a
digital contact sheet, instead of just a verbal list.

* Bigger Previews. The Preview Windows are now four times larger than they
used to be.

There’s much more.... each of the chapters will have opening highlights about what’s
new to a particular plug-in.
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COMMON UI ELEMENTS

The most of the plug-in Uls share certain similar elements, such as Kai’s logo, a Help but-
ton, an Options menu for accessing preferences and plug-in-specific features, a Presets
menu, and standard control buttons for adding and deleting presets, and cancelling or
accepting plug-in settings.

Kai Logo

In general, clicking on the Kai logo (located in the upper, left-hand corner of the Uls) will
black out the UI and give you a full-screen preview of what your effect will look like
when applied. For plug-ins that do not offer full-screen previews, the Kai logo will mini-
mize the plug-in Ul, allowing you to view more of your source image.

Help Button

Selecting the Help command will launch the online help system and display the help text
for the extension currently in use. Once inside the online help system you can access
the help text for any of the other extensions, as well as General Help and
Troubleshooting.

Options Menu

Most of the KPT 3 extensions have an Options menu located near the upper, right-hand
corner of the user interface. This menu contains both extension-specific options and
global options, including accessing the online help system and setting preferences.
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Common UI Elements

Info Bar

In the lower, left corner of all of the User interfaces is an empty gray area. As you move
the cursor over various Ul elements, text will appear in this area to let you know what
the UI element that you are currently pointing at is called. Further, as you use the vari-
ous controls, the Info Bar will show you the current settings for the parameter that you
are changing.

Presets Menu

At the bottom center of all of the user interfaces (except for the Lens f/x interface) is a
small, inverted triangle symbol. Pressing on this symbol will result in a pop-up menu of
presets for the plug-in that you are currently using.

Control Buttons

In the lower, right-hand corner of each extension Ul are four circle-symbol icons which
are used to add or delete presets, cancel the extension U, or accept the settings and
apply them to the selection.

Delete Preset

The Delete Preset button actually activates the Presets Manager, allowing you to delete
single or multiple presets, as well as perform other preset functions.

Add Preset

The Add Preset button, when clicked on, presents you with a simple dialog box for nam-
ing and saving the settings currently in effect as a preset.
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Cancel

Clicking this button cancels the extension user interface without making any changes to
your selected artwork.

OK

The OK button accepts your extension settings, exits the Ul, and applies your effect to
the selected area(s) of your artwork.

Kai’s Power Tools Explorer’s Guide
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Preferences

PREFERENCES

Selecting the Preferences command from the Options menu will display the KPT 3
Preferences dialog box, where you can specify various options for your Kai’s Power Tools
3 environment.

Load Gradient from Image

When selected, this option instructs the Gradient Designer or Texture Explorer plug-ins
to sample a one-pixel-wide horizontal strip from the center of your image and use it as
the basis for your initial gradient within these plug-ins.

Smooth Gradient from Image
This option functions exactly the same as the Load Gradient from Image option, but it
smooths out any harsh color transitions in the sample gradient.

Launch to Previous State

This option tells each extension to “remember” the settings in use the last time that
you applied that effect. These settings will then be intact the next time you open that
extension.
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Tablet Enhancement

If you are using a graphics tablet and experience odd behavior (from your tablet, that is)
select this option. Some graphics tablets will perform more reliably with this option
selected.

Graphical Presets

When selected, the Presets menus of the Spheroid Designer, Gradient Designer, Texture
Explorer and Interform plug-ins will display a scrolling palette of graphical presets, rather
than the standard text-based menus.

Blackout Screen

If this option is selected, the entire screen behind the extension UI will be filled with
black, hiding the host application window. This option is designed to remove back-
ground distractions and generally look cool. This option does not apply to the Lens f/x
filters, as viewing your image while you work is essential when using the Lens f/x filters.

Overriding Preferences

If you wish to temporarily override the Graphical Presets or Blackout Screen options, sim-
ply hold down the spacebar while pressing on the Presets menu (to toggle Graphical
Presets) or when selecting a plug-in from the Filter menu (to toggle Blackout Screen).
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Presets

PRESETS

While the primary purpose of Kai’s Power Tools is to allow you to create an infinite vari-
ety of extraordinarily cool images and effects, we do include hundreds of presets for the
Spheroid Designer, Gradient Designer, Texture Explorer and Interform. These presets can
be used to make interesting and attractive modifications to your image when you don’t
have time to create your own spheres, gradients or textures.

Presets Menu

At the bottom center of most of the Kai’s Power Tools user interfaces is a pop-up presets
menu. Pressing on this menu will display either a text list of all available presets, or a
graphical palette containing thumbnails of all available presets. (You can select whether
you prefer a graphical or text-based Presets menu in the Preferences dialog box. See
Preferences, above.)

If all available presets cannot be displayed, text menus will have arrows at the top or
bottom to indicate in which direction the additional choices can be found.

When using graphical palettes you can simply drag the cursor above the palette to scroll
up aand view more presets, or down to view more presets in that direction. Also, when
you scroll to the end of the palette, it will loop around to the beginning (or end) and
continue scrolling. This eliminates having to wait to go all the way from top to bottom
(or vice versa).

If you hold down the Shift key and click on the Presets menu (when using Graphical
Presets), the presets palette will appear and will remain on the screen without you hav-
ing to keep the mouse button held down. In this state you can simply move the cursor
above or below the palette to scroll, and click on a preset to select it.
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Finally, your graphical presets normally scroll one row at a time. If you hold down the
Control key while scrolling, your presets will scroll one preset at a time, with each preset
shifting to make room for the new arrival. This lets you see new presets much faster,
but you only get to see one at a time, so you are really scolling through the entire set of
presets more slowly.

Presets Manager

Importing, exporting, and deleting presets is accomplished via the Presets Manager dia-
log box, which can be accessed by clicking on the Delete/Preset Manager button.

Once you are in the Presets Manager, you can scroll through a list of presets, selecting
individual presets, or multiple presets using the Shift or Command keys (on a Macintosh)
or the Shift and Control keys (on a Windows-based machine). (Shift allows multiple adja-
cent selections, Command/Control allows multiple non-adjacent selections.)

To get a preview of any single preset, simply double-click on it in the list.

Importing Presets

Presets can be imported by clicking on the Import button, and then navigating the stan-
dard Open dialog box to select and open the desired presets file.

Exporting Presets

Presets can be exported by selecting all of the presets you wish to export (using the Shift
and Command/Control keys) and then clicking on the Export button. You will be pre-
sented with a standard Save dialog box, allowing you to specify the name and destina-
tion of the presets file.
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Presets

Deleting Presets

Presets can be deleted by selecting single or multiple presets from the list and then click-
ing on the Delete button. You will be presented with an warning message to ensure

that you don’t delete presets unintentionally.
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Apply Modes

Kai’s Power Tools Explorer’s Guide

37

sapoy A(ddy



